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Welcome 
Welcome to MSC-LIMS Insights.   

 
This newsletter will help current MSC-LIMS users 

get the most out of their software, and will 

complement the product literature and demo 
that prospective users can find on our web site 

at www.msc-lims.com.   
 

Join our mailing list for more information.  Sign up at www.msc-lims.com/lims/maillist.html. 

 
This newsletter is for and about MSC-LIMS users.  We welcome your comments, and your suggestions for topics you 

would like to see addressed in upcoming issues.  Please send your thoughts to newsletter@msc-lims.com.    
 

MSC-LIMS and SQL Server 
As we announced in the previous issue of this newsletter we are currently 

developing MSC-LIMS version 5.0 for SQL Server.  MSC-LIMS 5.0 replaces 
the earlier Access back end database with a SQL Server database for 

improved reliability, scalability, and security. 
 

While many MSC-LIMS sites with large databases welcome the move to a 

SQL Server database, we understand that others may have questions.  In 
this and future newsletters we will address some of these questions. 

 
What are the benefits with SQL Server? 

Reliability.  SQL Server databases are not subject to corruption that may 
occur with an Access database in a multi-user installation due to bad 

network connections or workstation crashes.  SQL Server databases can 

be restored up to the point of failure, whereas an Access database can 
only be restored to its last backup. 

 
Scalability.  The number of LIMS users and the size of the database can 

increase significantly without the performance degradation encountered 

with an Access database. 
 

Security.  SQL Server databases are inherently more secure than an 
Access database.  MSC-LIMS 5.0 will use SQL Server’s Windows 

authentication so once logged on to Windows you can start MSC-LIMS 

without any additional login. 
 

(Continued on page 5) 
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From the Developer 
Since we announced the upcoming SQL Server version of MSC-LIMS in the previous issue of MSC-LIMS Insights, 
development has proceeded and we recently delivered an early version to one customer for testing.   
 

If you have a large MSC-LIMS database, many users or could otherwise benefit from a SQL Server version and would 

like to test the early version, please let us know.  We hope to have a couple more sites testing the early SQL Server 
version later this year.  See “MSC-LIMS and SQL Server” in this issue for more information. 

 
As always, please let us know if you have any comments, questions, or concerns about MSC-LIMS or our long term 

plans.  We always welcome your thoughts. 

       
Rick Collard is the founder of Mountain States Consulting, LLC and the principal developer of the MSC-LIMS software.  
You can reach Rick by email at rcollard@msc-lims.com. 
 
 

How to Query Completed, Unreported, and Unapproved 
Batches 
If yours is a commercial lab you likely work primarily 
with sample batches in MSC-LIMS.  You log samples by 

batch, even for single-sample batches.  You report 
results by batch so that one final report has results for 

all samples in a single batch.  And you generate 

invoices by sample batch. 
 

When you rely on sample batches in MSC-LIMS, you 
will find it helpful to query samples by batch status.  

This article shows you how to query completed, 
completed and unreported, and unapproved batches. 

 

All queries in MSC-LIMS query samples.  For example, 
when you perform a query with a batch number 

criterion, you are asking the LIMS to find all samples 
with that batch number or all samples in the batch.  

The result of your query is still a list of samples. When 

you need to query batches with specific criteria such as 
completed batches, remember that the results of the 

query will still be a list of samples in batches matching 
your criteria.  That may be confusing so let’s look at a 

few examples. 

 
Completed Batches 

To query completed samples we only need to enable 
the Completed option on the Additional tab of the 

query controls.  However, to find completed batches 
where all samples in the batch are complete requires a 

subquery or nested query using a Structured Query 

Language (SQL) expression.  A subquery produces a 

set of data that can be used as part of a query 
criterion. 

 
Without checking each individual analysis in the 

sample, we can find a completed sample simply by 

looking for a non-blank completed date since the LIMS 
automatically detects when all analyses have a result 

and adds the completed date.  With a subquery we can 
generate a set of batch numbers for completed 

batches by finding batches where the number of 
sample IDs in the batch is equal to the number of non-

blank completed dates in the batch.  We can then find 

samples within completed batches by finding samples 
with a batch number in the set of batch numbers 

produced by the subquery. 
 

To query completed batches first add the following 

SQL expression to the SQL Expressions screen on the 
Setup menu. 

 
Name: Completed Batches 

 

SQL: Batch IN (SELECT Batch FROM Sample GROUP 
BY Batch HAVING Count(SampleID) = 

Count(CompletedDate)) 
 

 
(Continued on next page)
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(Continued from previous page) 
 

You can now use the Completed Batches expression as 

a criterion anywhere you query samples by selecting 
the expression from the pick list on the SQL tab of the 

query controls.  And you can combine the expression 
with any other criteria.  For example, if you want to 

find all batches completed for customer ABC Company 
received this month, select the customer, enter the 

received date range, and select the Completed Batches 

SQL expression. 
 

Completed Unreported Batches 
If you are using the System Configuration screen 

option that automatically sets sample reported dates, 

you can extend our previous example and find 
completed and unreported batches with two 

subqueries.  Just as in our previous example, the first 
subquery generates a set of batch numbers for 

completed batches.  The second subquery generates a 

set of batch numbers where the number of samples in 
the batch is different than the number of non-blank 

reported dates in the batch to reveal unreported 
batches.  The intersection of the sets resulting from 

these two subqueries is a list of batches that are both 
completed and unreported.  To query samples in 

completed unreported batches add the following 

expression to the SQL Expressions screen then select 
the expression on the SQL tab of the query controls. 

 
Name: Completed Unreported Batches 

 

SQL: Batch IN (SELECT Batch FROM Sample GROUP 
BY Batch HAVING Count(SampleID) = 

Count(CompletedDate)) AND  
Batch IN (SELECT Batch FROM Sample GROUP 

BY Batch HAVING Count(SampleID) <> 
Count(ReportedDate)) 

 

Unapproved Batches 
If you are using sample approval in MSC-LIMS, you 

can find unapproved samples by simply selecting the 
Unapproved option on the Additional tab of the query 

controls.  In an unapproved sample, the only 

incomplete analysis is the defined “Approval” analyte.  
Therefore, an unapproved batch is a batch where all 

samples in the batch are unapproved. 

 
 

Multiple subqueries are also required to find 

unapproved batches.  The first subquery finds samples 
having only one incomplete analysis.  The second 

subquery finds samples with an incomplete “Approval” 
analyte.  The intersection of the sets produced by 

these two queries yields a list of unapproved samples.  
If the count of unapproved samples in a batch is equal 

to the total number of samples in the batch then the 

batch is unapproved.  To query samples in unapproved 
batches add the following expression to the SQL 

Expressions screen then select the expression on the 
SQL tab of the query controls. 

 

Name: Unapproved Batches 
 

SQL: Batch IN (SELECT Batch FROM Sample 
WHERE Batch IS NOT NULL AND 

((Sample.SampleID IN (SELECT SampleID 

FROM SampleAnalysis WHERE AnalysisResult 
IS NULL AND ResultTypeID IS NULL GROUP 

BY SampleID HAVING Count(AnalysisID) = 1)) 
AND (Sample.SampleID IN (SELECT SampleID 

FROM SampleAnalysis WHERE AnalysisID=999 
AND AnalysisResult IS  NULL AND 

ResultTypeID IS NULL))) 

GROUP BY Batch 
HAVING Count(SampleID) = (SELECT 

Count(SampleID) FROM Sample AS S2 WHERE 
S2.Batch = Sample.Batch)) 

 

Replace 999 in the expression above with the internal 
AnalysisID for your “Approval" analyte.  To find the 

AnalysisID open any sample query dialog and select 
the Unapproved check box on the Additional tab, click 

Query, then select the SQL tab and find 'WHERE 
AnalysisID=n' in the 'SQL for last query' field. Replace 

999 with n. 

 
Like any sample query, a query using one of the above 

SQL expressions produces a list of samples.  You can 
get a list of just the batch numbers by exporting to 

Excel.  Export a Sample Summary report of the queried 

samples to the generic MSC-LIMS Export Template, 
delete all but the Batch column then use the Remove 

Duplicates option on the Data tab. 
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Using Excel’s Formula Evaluator 
The example Excel export templates installed with 

MSC-LIMS use formulas to display LIMS data on a 
report worksheet.  Some of the formulas may be 

lengthy and difficult to comprehend.  If you need to 

modify one of these formulas, wonder why your 
formula results in an error, or just want to understand 

how the formula works, Excel’s formula evaluator is a 
handy tool. 

 

Understanding how a lengthy formula calculates the 
final result can be difficult because of nested functions 

and logical tests.  In Excel 2010 or newer, the formula 
evaluator solves a formula one step at a time allowing 

you to see how the formula is calculated. 
 

Let’s take a look at an example.  If you export a 

Sample Summary report to the Final Report Example 
template, you will find this formula to display the result 

for the first analyte in the first sample in cell N25: 
 
=IF(ISBLANK(INDEX(AnalysisResultFormatted, 

ROW() - ROW(OneAnalysisResults) + 1)), 

"",INDEX(AnalysisResultFormatted, ROW() - 

ROW(OneAnalysisResults) + 1)) 

 
With cell N25 selected, select Evaluate Formula in the 

Formula Auditing group on the Formulas tab.   

 

 
 

Use the Evaluate button to view the value of the 
underlined portion of the formula. The result will 

appear in italics. 
 

 
 

Continue clicking the Evaluate button to view each 
underlined step in the formula’s calculation and its 

italicized result.  If there is a result for the first analyte 

in the first sample (i.e. cell N25 is not blank) the final 
evaluation step in the formula will appear as shown 

below. 
 

 
 
After fully evaluating the original lengthy formula, we 

can see the formula has been reduced to a simple IF 

function in the form IF(condition, result_if_true, 
result_if_false).  Since cell W2 on the AnalysisData 

sheet does have a value (i.e. there is a result for the 
first sample’s first analyte), the result of the nested 

ISBLANK function as the condition portion of the IF 
function is FALSE.  Therefore, the result of the IF 

function is the value in cell W2 on the AnalysisData 

sheet. 
 

Whether you are developing a complex formula or just 
trying to understand an existing formula, use Excel’s 

formula evaluator to visually break the formula down 

to a series of simple calculation steps.  Add this tool to 
your Excel arsenal and you will quickly understand and 

troubleshoot daunting formulas. 

 



  MMSSCC--LLIIMMSSTTMM

Insights 

August, 2017  Page 5 of 6 

MSC-LIMS and SQL Server 
(Continued from page 1) 

 

Integration.  While integrating LIMS data with external 
applications has always been possible, some will find it 

easier to integrate with SQL Server databases. 
 

What are the tradeoffs with SQL Server? 
Installing SQL Server, backing up and maintaining a 

SQL Server database, and managing Windows login 

accounts are tasks that require more thought and 
planning than equivalent procedures with an Access 

database. 
 

When will MSC-LIMS 5.0 be available? 

An early version of MSC-LIMS for SQL Server is 
currently installed for testing at one site.  We expect 

additional sites to begin testing the early version later 
this year.  The official release of MSC-LIMS 5.0 will 

likely occur during the second half of 2018.

Will there be additional costs for MSC-LIMS 5.0? 
Although we have not finalized the price list for version 

5.0, we do expect an increase in the cost for Annual 

Subscriptions.  The cost for Annual Maintenance for 
Full System licensees is also expected to increase.  

Migrating an existing MSC-LIMS database to SQL 
Server requires a full copy of Microsoft Access and 

other utilities from Microsoft.  For those who do not 
have Microsoft Access or prefer assistance, we will 

offer one-time database migration for an additional 

fee.  Full System licensees with customized systems 
will also incur a nominal one-time fee to reapply their 

customizations. 
 

Do I have to upgrade to MSC-LIMS 5.0? 

No.  While there will be no additional development to 
MSC-LIMS 4.x, we will continue to support it and you 

can continue to run version 4.x.   

Notes from Technical Support

Result High and Low Warning Flags 

A user recently asked: 
 

Could you please tell me why when a spec is listed as 
11-11.4 and a result is 11.4, LIMS gives an ‘H’ warning 
for the result? 
 
The 'H' for high is appearing because the result value 

is at or above the warning maximum value specified 
for the analyte in the sample's project.  Review the 

specifications in the Projects setup screen and set the 
Warning Max field to a value slightly above 11.4 (e.g. 

11.40001).  Note that the Report Specs field is simply 

text that allows you to specify an acceptable result for 
a final report.  'H'igh and 'L'ow flags are appended by 

comparing the result value to the warning maximum 
and minimum values.   

 

You can view a sample analysis' specifications by 
double-clicking the Result Value field (or right-click and 

choose Result Specifications) in either results entry 
screen.  Specifications are copied to the sample at 

login from the sample's project.  Correcting a project's 
specifications will affect all future samples.  If the 

analysis does not yet have a result you can correct a 

sample's analysis specifications using the Update 
Min/Max button on the Analyses setup screen.  See 

"Understanding Analysis Specifications" in MSC-LIMS 

Insights No. 22 for more information.  

Add an Analysis to Many Projects 

A user updating projects asked: 
 

If I wanted to add an analysis to all existing projects, 
how would I do that?  Or do I have to go in to each 
individual one and make changes? 
 
You do have to add the analysis to each individual 

project but there are some editing techniques that can 
help.  Open the Projects setup screen, switch to edit 

mode then click the View All button.  Add the analysis 
to the first project, click or tab off the new analysis 

record then click the record selector (the box at the far 

left of the record) and use Ctrl+C to copy.  Move to 
the next project using the project record selectors at 

the bottom left of the screen or click in the project 
name field and use Page Down.  Click the asterisk new 

record selector at the bottom of the list of analyses 

and use Ctrl+V to paste the copied analysis.  
 

Graph a Single Analyte 

A user recently asked: 
 

How can I graph a single analyte in the LIMS or in 
Excel? 
 

(Continued on next page) 
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(Continued from previous page) 

 

Use the Analyte Comparison report on the Samples 
menu to create a quick trend graph for a single 

analyte.  In the Analyte Comparison Setup screen, 
select the single analyte, enter your sample query 

criteria, enable the “Include Graph(s)” option, click the 
Query button, then click the Preview button to view 

the report.  The graph will appear below the tabular 

data on the report’s last page. 
 

If you prefer to create your own graph in Excel, export 
the Analyte Comparison report (with or without the 

graph) to the generic MSC-LIMS Export Template and 

the selected analyte’s results will be found in 
worksheet column C labeled “1” for the report’s first 

analyte.   

 

Accessing Excel’s Name Manager 

A user modifying an Excel export template recently 
asked: 

 

We need to go to cell B6 and navigate to Insert | 
Name | Define then select OneSampleResults and 
extend the column reference range. In Excel 2016 I 
can’t find Insert | Name | Define. Can you direct me? 
 

Although Insert | Name | Define no longer exists on 
the ribbon in newer versions of Excel, you can still use 

its keystroke shortcut Alt+I, N, D to open the Name 

Manager.  Alternatively, you will find the Name 
Manager on the Formulas tab of the ribbon.  Note that 

if you insert a column anywhere within the existing 

OneSampleResults named range, Excel will 
automatically expand the named range.  You can also 

change the OneSampleResults range to include more 
columns (e.g. $A$4:$Z$4) than currently used so you 

don't have to remember to change it each time you 

add a new column.   

 

Significant Figure Rounding in Excel 

A user developing an Excel final report template with 
calculations asked: 

 
Is there a way to round columns to 2 significant 
figures? 
 
Yes, you can round to any number of significant digits 

in Excel with this generic formula: 
 
=ROUND(number,digits-

(1+INT(LOG10(ABS(number))))) 

 
Where 'number' is the value to round and 'digits' is the 

number of significant digits.  To round the value in cell 
B5 to two significant figures, for example, use this 

formula in another cell: 

 

=ROUND(B5,2-(1+INT(LOG10(ABS(B5)))))  

 

For Customers Only 
This section of MSC-LIMS Insights is devoted to current users of MSC-LIMS.  Here we briefly introduce only the most 
recent additions to MSC-LIMS.com Customers Only pages. Use your login name and password to log on to the 

Customers Only section of our website.

File Library 

Final Report - N Samples per Page.xlt 

This new example Excel final report template includes 
a sample header preceding each sample’s results with 

a Settings sheet option to specify the number of 
samples on each page.  See the template's Read Me 

sheet for details.    

Contact Us 
Questions, comments, suggestions?  
Reach us at: 

Mountain States Consulting, LLC 
970 West Broadway #471 
PO Box 30000 
Jackson, Wyoming  83002  USA 
Ph  +1 307-733-1442 
Fax +1 303-379-6850 
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Copyright © 2017 Mountain States Consulting, LLC.   
All rights reserved.  
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